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Before 
we begin…



Main Project Folder



Is there a god? 
What’s the meaning 

of life? And where should 

my Web projects files go?

Photo by Grag Rakozy on Unsplash



We need a place to store all your project work 

Go to your Documents folder 

Create a new folder named exactly Web Dev Projects



1㌱

2㌲



If you are not using your own computer, go to a cloud 
drive (e.g., Dropbox, iCloud Drive, One Drive, Box, or 
Google Drive) 

Create a new folder named exactly Web Dev Projects 
inside a Documents folder (create the Documents folder 
if it doesn’t already exist)





Sometimes cloud drives 
like to move some or all of 
your files in them off your 
computer & into the Cloud 

Result? Your pages don’t 
work because key files are 
no longer on your 
computer 

Fix: re-download all files



✏ SIDE NOTE

For a video about this process, see Visual Studio Code - 
Initial Info - Main Project Folder at vimeo.com/
758991172



Why VS 
Code?



I’ve always been looking for an editor that met all 3 
criteria — with VS Code, I found it

Free

Cross-platform 

⊞�

Powerful



Visual Studio Code is a powerful source code editor 

» Debugging 
» Embedded Git control 
» Syntax highlighting 
» Intelligent code completion 
» Snippets 
» Code refactoring 
» Highly customizable theme, keyboard shortcuts, & 

preferences 
» Updated every month!



Most popular developer 
IDEs according to 2023 
Stack Overflow Developer 
Survey

Visual Studio Code 74%

Visual Studio 28%

  IntelliJ IDEA 27%

 Notepad++ 25%

Vim 22%

Android Studio 17%

PyCharm 15%

Jupyter Notebook 13%

Sublime Text 13%

Neovim 12%



Installation





VS Code is available for download at 
code.visualstudio.com

https://code.visualstudio.com


✏ SIDE NOTE

Microsoft also makes a developers’ tool named Visual 
Studio for those who code in .NET & C++ (& many 
other languages) that dates back to 1997 

Visual Studio ≠ Visual Studio Code 

Yes, this is confusing 

Make sure you are using Visual Studio Code!



Click this







A file named something like VSCode-darwin-
stable.zip will appear in Downloads 

Double-click on the ZIP file & a few moments later you 
will see Visual Studio Code.app



Drag VS Code into the Applications folder



Toss the ZIP file into the Trash (or just select the file & 
press ⌘⌫)



c



A file named something like VSCodeSetup-
x64-1.24.0.exe will download 

Double-click on the EXE installer



If you’re asked if you want to “allow the following 
program to install software on this computer”, click Yes 

Click Next 

Accept the agreement 

Click on Next until you click on Install 

Click Finish



Toss the EXE installer into the Recycle Bin





A file named something like code_1.38.0-1567547996_
amd64.deb will download 

Debian/Ubuntu: sudo apt install ./<file>.deb

Installing the .deb package automatically installs the 
APT repository & signing key to enable auto-updating 
using your system’s package manager



Snap: sudo snap install --classic code 

RHEL, Fedora, & CentOS: sudo dnf install code or 
sudo yum install code 

openSUSE & SLE-based: sudo zypper install code 

Arch: makepkg -si visual-studio-code-bin 

Nix: nix-env -i vscode



✏ SIDE NOTE

You can also run Visual Studio Code in your Web 
browser — yes, really! 

Information about that is in the Bonus section at the 
end



You should have VS Code installed — now open it



GrannePacks



VS Code does a lot out-of-the-box, but you can add on 
almost any feature you can think of via extensions



Go to the Extensions View of VS 
Code by clicking on the 5th icon 
down (     ) on the Activity Bar on 
the left side of VS Code 

You could also: 

» View > Extensions 
» Press ⇧⌘X/Ctrl+Shift+X



You can install extensions one at a time, or you can 
install an extension pack that installs several at once



❷ Install these 3 extensions

❶ Search for granne



Using 
VS Code



Let’s take a tour of 
Visual Studio Code



The User Interface





Editor



Breadcrumb



Breadcrumb



Breadcrumb



Minimap



Activity Bar



Activity Bar buttons change the view 
in the Primary Side Bar, here showing 
Explorer View



Search button on the Activity Bar 
switches to the Search View



Search View lets you search & replace 
in all project files



This 
searches 
every page 
in the 
project

This searches this page only 
(⌘F/Ctrl+F to Find; ⌥⌘F/
Ctrl+H to Find & Replace)



Extensions button on the Activity Bar 
switches to the Extensions View, so 
you can add new features to VS Code



Name of current project (always 
shown in ALL-CAPS for stylistic 
reasons)



All files & folders in current project/folder



The same project using my file manager, with the 
same files & folders  

(ignore .vscode from the previous slide; it’s here, but it’s hidden)



Project in 
VS Code

Same files in a folder 
in my file manager



You can open individual files in VS Code, 
but do not do that! 

Instead, always open a project/folder 

All the files in a project are related to each 
other, & so you need to have all of them 
available, or VS Code will do weird things



Currently open editors/files



These are the same files; all the files in 
the project are listed below, while open 
editors/files are listed above



Why do I say “editors/files”? Because 
Settings is in the Editors area, but it is 
not a file



Tabs



In fact, Open Editors & Tabs are the same…



In fact, Open Editors & Tabs are the same…



It’s all connected! �



It’s all connected! �



It’s all connected! �



Live Preview 
(requires 
extension)



Split Editor (more 
in a moment)



Title Bar



Back & Forward buttons



Back to last file (& last cursor position)



Forward to next file (& last cursor position)



Customize layout buttons





Drag sections from Primary 
Side Bar to Secondary Side 
Bar as desired



Don’t get too crazy



Command Center





Opens Command Palette (more in a moment)



Scroll down to select recently opened files



Splits the current editor to show the selected file on the right





1 2

You now have 2 editor groups



To remove the split, close all the tabs in an editor group 



Status Bar



Panels 
1. Terminal 
2. Problems 
3. Output 
4. Debug



You can use this, but I’d rather open up a 
specific panel for a particular reason



To open Problems, press  
⇧⌘M/Ctrl+Shift+M or…



…click any of these 
to show Problems

To open Problems, press  
⇧⌘M/Ctrl+Shift+M or…



Click on a 
specific 
problem to 
jump to that 
line in that file 
(here, line 92 
in main.css)



Integrated Terminal



Settings



Now we need to edit VS Code’s settings 

: Code > Preferences > Settings (or press ⌘,) 

⊞: (☰) > File > Preferences > Settings (or press Ctrl+,)



Let’s close 
the Sidebar…



Open Settings (JSON)





VS Code stores settings in settings.json 

JSON: JavaScript Object Notation 

Open standard file format 

Stores data in key:value pairs & arrays



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

"Key": Value 
(Boolean or #)

"Key": "Value" 
(String)

"Key": [Array]



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

Comments not allowed 
in JSON, but are in 
settings.json 
(thanks, Microsoft!)



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

Commas after every key:value pair…

…except the last one



✏ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

Commas after every value in an array…

…except the last one



Let’s replace the default settings with some I’ve created 

Go to https://chnsa.ws/1c7 

Click the Raw button 

On the following page, press ⌘A/Ctrl+A to select all of 
the code 

Press ⌘C/Ctrl+C to copy the snippet code (everything 
from — & including! — the first { to the last })

http://chnsa.ws/1c7


Go back to VS Code & click in User Settings 

Select all of the content in your settings by pressing ⌘A/Ctrl+A 

Paste the settings you copied with ⌘V/Ctrl+V, overwriting 
what was there 

Save what you just pasted in by pressing ⌘S/Ctrl+S (if the font 
gets bigger, it worked) 

Close User Settings by clicking the × on its tab or by pressing 
⌘W/Ctrl+W



Key Features



Command Palette



⌘⇧P/Ctrl+Shift+P opens the Command Palette so you 
can run editor commands that affect your code 

You will use this a lot, so get used to it



All editor commands

⌘⇧P/Ctrl+Shift+P



Filter commands

⌘⇧P/Ctrl+Shift+P



Most recent editor commands at top

⌘⇧P/Ctrl+Shift+P



IntelliSense



IntelliSense combines several features 

We care about code completion & quick info



Code completion 

As you type, IntelliSense lists suggestions in a small pop 
up 

Suggestions depend on the language you’re working in  

If you continue typing, the list filters to include only 
items containing your typed characters 

Press Tab or Enter to insert the selected list item







 Now type a > to complete the tag 





Let’s hit ↩/Enter to properly format…





If only there was a way 

to automate that… �



If you don’t see the code completion pop up, press ⌃␣/
Ctrl+Space



Quick info 

Very short documentation explaining the purpose of… 

» an HTML element 
» a CSS property or value 
» a JavaScript method & parameter info 
» a Sass variable 
» & much more!













By default, you won’t see quick info 

Here’s how to enable it…



Type <p & hover over 
the far right of the blue 
bar until you see >



Click on the > & quick info appears 

You only have to do this once per language



If you don’t see the quick info pop up, press ⌃␣/
Ctrl+Space



Emmet



Emmet (formerly Zen Coding) is a set of plug-ins for 
text editors that make it very fast to code & edit HTML, 
CSS, XML, & other structured code formats 

Started in 2008 & still going strong 

Some editors (like VS Code) come with Emmet built-in 

� � �



You type p*3 & Emmet outputs: 

<p>
  |
</p>
<p>

</p>
<p>

</p>



What I typed



Code completion/Emmet



Quick info



You type ul>li*3 & Emmet outputs: 

<ul>
  <li>|</li>
  <li></li>
  <li></li>
</ul>





You type p+ul>li*3 & Emmet outputs: 

<p>
  |
</p>
<ul>
  <li></li>
  <li></li>
  <li></li>
</ul>





You type div.container>div.row>article>
h2{Article Title}^aside>h2{Aside Title}

+p*2>lorem & Emmet outputs… well, just take a look







div.container
>div.row
>article
>h2{Article Title}
^aside
>h2{Aside Title}
+p*2>lorem

<div class="container">
  <div class="row">
    <article>
      <h2>Article Title</h2>
    </article>
    <aside>
      <h2>Aside Title</h2>
      <p>
        Lorem ipsum…
      </p>
      <p>
        Consequatur, tempore? …
      </p>
    </aside>
  </div>
</div>



VS Code enables Emmet expansions by default in 
HTML, Haml, Jade, Slim, JSX, XML, XSL, CSS, SCSS, 
SASS, LESS & Stylus files — & any language that 
inherits from any of those, like Handlebars & PHP



Emmet does a lot more than expanding abbreviations 

Matches opening & closing tags • Select all content 
inside tags • Wrap selected content inside tags • Control 
insertion point placement after expansion • Easily jump 
to the next edit point • Toggle comments • Remove tags 
• Merge lines — without selections! • Automatically 
insert image height & width • Evaluate math 
expressions • Increment & decrement numbers • Copy 
CSS values to vendor-prefixed properties



To perform almost all of those actions, you use the 
Command Palette or come up with keyboard shortcuts 
(more on those later)





For much more on Emmet, see my presentation 
Emmet: Automate Your HTML & CSS 



Snippets



Remember how VS Code formats the <p> tags by 
default when I type them?



 Now type a > to complete the tag 





I don’t want <p>|</p> 

I want 
<p>
  |
</p> 

Snippets in VS Code allow me to do that because they 
let you define small patterns of code that expand when 
you type a trigger prefix



Simply type the start of a snippet, like p (you decide 
what the prefix will be) 

Code completion shows what will happen if you press 
Enter 

Quick info tells you what will happen if you press Enter



Let’s look at this in 
detail…



This icon 
means it’s 
from Emmet

This icon 
means it’s a 
snippet

Code preview



Perfect!



Insertion point’s 1st  
position

Press Tab to jump to 
2nd position







Note the 5 tab stops



Remember when we installed this? 
It installed HTML-, CSS-, & SCSS-
related snippets I created











This is the built-in, bare bones Emmet snippet



This is the snippet I created





Sometimes Emmet’s & mine are similar





✏ SIDE NOTE

Want to create your own? 

See the Bonus section at the end



Keyboard Shortcuts



Many (most?) commands have a key command 
equivalent 

For example, invoke the Command Palette & search for 
Join Lines



Mac users see a 
key command: ⌃J

Windows & Linux users 

don’t get a key command ☹



However, VS Code includes the ability to set or change 
key commands for everything



: Code > Preferences > Keyboard Shortcuts 

⊞: File > Preferences > Keyboard Shortcuts



In the search box at the top of Keyboard Shortcuts, 
enter join (you don’t need to press ↩/Enter) 

Look for Join Lines 

 users get ^J — let’s provide ⊞ & � with Ctrl+J too















Now that you’ve changed the command, nothing appears











Change the following (you will thank me later!): 

editor.emmet.action.wrapWithAbbreviation 
⌘E ⌘R/Ctrl+E Ctrl+R

Why the ⌘E/Ctrl+E first? Because that way I know it’s 
going to be a keyboard shortcut for Emmet 

⌘E/Ctrl+E for Emmet, then ⌘R/Ctrl+R for Wrap



DEMO!



Now let’s combine our new key command with an 
Emmet abbreviation that will blow your mind 

One more that a student accidentally discovered…



Say you have this: 

On the seve…

The record…

The birth… 

Select all 3 paragraphs 

Press ⌘E ⌘R/Ctrl+E Ctrl+R 
to open Emmet Wrap 

Enter in p*

The results: 

<p>On the seve…</p>
<p>The record…</p>
<p>The birth…</p>



Say you have this: 

On the seve…

The record…

The birth… 

Select all 3 paragraphs 

Press ⌘E ⌘R/Ctrl+E Ctrl+R 
to open Emmet Wrap 

Enter in p*

The results: 

<p>On the seve…</p>
<p>The record…</p>
<p>The birth…</p>



Say you have this: 

On the seve…

The record…

The birth… 

Select all 3 paragraphs 

Press ⌘E ⌘R/Ctrl+E Ctrl+R 
to open Emmet Wrap 

Enter in ul>li*

The results: 

<ul> 
  <li>On the seve…</li>
 <li>The record…</li>
 <li>The birth…</li>
</ul>



Say you have this: 

On the seve…

The record…

The birth… 

Select all 3 paragraphs 

Press ⌘E ⌘R/Ctrl+E Ctrl+R 
to open Emmet Wrap 

Enter in ul>li*

The results: 

<ul> 
  <li>On the seve…</li>
 <li>The record…</li>
 <li>The birth…</li>
</ul>



Emmet: Balance (outward)

⌘E ⌘↑/Ctrl+E Ctrl+↑

⌘E/Ctrl+E for Emmet, then ⌘�/Ctrl+� for outward 

Emmet: Balance (inward)

⌘E ⌘↓/Ctrl+E Ctrl+↓

⌘E/Ctrl+E for Emmet, then ⌘�/Ctrl+� for inward



Emmet: Update Image Size 
⌘E ⌘I/Ctrl+E Ctrl+I 

⌘E/Ctrl+E for Emmet, then ⌘I/Ctrl+I for Image Size



Extensions 
& Themes





marketplace.visualstudio.com



Extensions installed by GrannePack HTML

Auto Close Tag Image Preview

Code Spell Checker indent-rainbow

Color Picker Live Server

File Templates Manager Placeholder Images

File Utils Project Templates

HTMLHint Projects+



Basics



File Templates Manager 

ꕹ 
Ivan Zakharchanka



Templates make it easy & quick to create new HTML (& 
other) files



Go to the Extensions View & install File Templates 
Manager by Ivan Zakharchanka



These are the 2 templates we’re going to work with 

HTML5 template: https://chnsa.ws/1b1 

Bootstrap 5 CDN template: https://chnsa.ws/1yn

http://chnsa.ws/1b1
https://chnsa.ws/1yn


Let’s fix the HTML5 template first 

File Templates Manager includes a template for 
HTML5, but I don’t like it, so we’re going to replace it 
with a better one I made



In other words, from this: To this:

<!DOCTYPE html>
<html lang="en">
<head>
  <meta charset="UTF-8">
  <title></title>
</head>
<body>
</body>
</html>

<!doctype html>
<html lang="en">

  <head>
    <meta charset="UTF-8">
    <title>Untitled Document</title>
    <link rel="stylesheet" href=
      "/css/main.css">
  </head>

  <body>

  </body>

</html>



Load this in your Web browser: chnsa.ws/1b1 (that’s a 
one, followed by a b, followed by a one)

http://chnsa.ws/1b1




Click on the Raw button



Press ⌘A/Ctrl+A to select all the text



Press ⌘C/Ctrl+C to copy the selected text 

Press ⌘W/Ctrl+W to close the browser tab



Now open up Visual Studio Code





Click on the Templates View title bar



These are default templates that 
are included with File Templates 
Manager (I deleted some that I 
never use)



Hover over HTML.html & you’ll see buttons



To work with individual templates, hover over the 
template’s row

Rename

Edit

Clone

Delete



Click on the Edit button on the 
HTML.html row



This is the HTML in the default 
template 

It ain’t great, so we’ll replace it 
with the code that you copied a 
few minutes ago



Press ⌘A/Ctrl+A to select all the text



Press ⌘V/Ctrl+V to paste the selected text 

Press ⌘S/Ctrl+S to save the changes to HTML.html 

Press ⌘W/Ctrl+W to close the editor



Now let’s create the Bootstrap 5 CDN template



Load this in your Web browser: chnsa.ws/1yn (that’s a 
one, followed by a y, followed by a n)

https://chnsa.ws/1yn




Click on the Raw button



Press ⌘A/Ctrl+A to select all the text



Press ⌘C/Ctrl+C to copy the selected text 

Press ⌘W/Ctrl+W to close the browser tab



Now go back to Visual Studio Code



Hover over the Templates View title bar  
& you’ll see 2 buttons



To create a new template, hover over the Templates 
View title bar

Create

Refresh



Click on the Create button



You will be asked for the title of 
your template 

Type this exactly: 
Bootstrap 5 CDN.html



It should look like this 

Now press ↩/Enter to create the new 
empty template



Press ⌘V/Ctrl+V to paste the new code you just copied 

Press ⌘S/Ctrl+S to save the changes to Bootstrap 5 CDN.html



Hey, you made a new template! � 

Press ⌘W/Ctrl+W to close the browser tab 

Click on the Templates View title bar to close Templates



You’ll never need to open Templates 
again unless you are creating, 
editing, or deleting a template



✏ SIDE NOTE

You probably won’t need these, but in case you do… 

Bootstrap 3 CDN template: https://chnsa.ws/1b2 

Bootstrap 4 CDN template: https://chnsa.ws/1b3

http://chnsa.ws/1b2
http://chnsa.ws/1b3


✏ SIDE NOTE

FYI where templates are stored (in case you want to 
back them up) 

: ~/Library/Application Support/Code/User/
CodeTemplates/ 

⊞: %HOME%
\AppData\Roaming\Code\User\globalStorage\

3axap4ehko.file-templates-manager (those letters & 
numbers may be different)



Now that File Templates Manager is installed, here’s 
how to use it



There are 2 ways to invoke File Templates Manager 

1. Using the Command Palette 
2. Right-clicking in the Explorer View where you see all 

the files & folders in your current project/folder



Method 1: Using the Command Palette



Invoke the Command Palette (⌘⇧P or Ctrl+Shift+P)



Type until you see New File From Template… appear 
& press ↩/Enter 

Now you would choose a template (coming up after 
looking at method 2)



Method 2: Right-clicking in the Explorer View



Right-click to bring up the context menu



Click on New File From Template…



No matter if you use method 1 or 2, 
the Command Palette now shows a 
list of templates (yours is probably 
longer because I removed several I 
don’t use) 

We want HTML.html



Type HTML until that template is selected & press ↩/Enter,  
or use your � to select HTML.html & press ↩/Enter,  
or just click on it



Type index, the name of the file you want to create, 
but do not type the extension, because that will be 
added for you, & then press ↩/Enter…



Here’s your new file, 
ready to edit!

…& notice it’s using the HTML5 
template we copied into File 
Templates Manager



Remember, do not type the file extension (.html, .css,  
.js) when you are creating a new file from a template



Don’t do it! Just use index, not index.html!



Ruh-roh



Right-click on the file &… 
1. Delete the file & re-create 

2. OR Rename the file �





A very important tip about using File Templates 
Manager — whatever is selected in Explorer View will 
become the parent to any new file you create from a 
template 

In other words, pay attention to what is selected in 
Explorer View before you create a new file 

Let me explain with 3 examples…



Here’s how to create a new file in the root of your 
project



I want to create a new file at the root 
of my project, so that it is a sibling of 
css, index.html, & products 

Note that nothing is selected — to do 
that, I clicked in the empty areas 
under FOO 

See the blue border around the area 
under FOO? That means anything I 
create will be directly in the root — 

perfect!



At this point, use method 1 (invoke the Command 
Palette directly with ⌘⇧P/Ctrl+Shift+P) or method 2 
(right-click) 

In these examples I’ll use method 2



Right-click to bring up the context 
menu 

(Notice where my pointer is)



Click on New File From Template…



The list of templates appears — we want HTML.html 

Type HTML until that template is selected & press ↩/Enter, 
or use your � to select it & press ↩/Enter,  
or just click on it



Enter the filename — in this case, foo — & 
press ↩/Enter (Remember, do not add the  
.html — it will be put there for you)



And there’s our new file! Notice that is 
exactly where I wanted it: at the root 
of my project, as a sibling of css, 
index.html, & products 

(It is not inside css — see how it’s not 
indented like main.css is under css?)



Here’s how to create a new file inside another folder



I want to create a new file inside 
products named product-1.html 

Note that nothing is selected — I 
could click on products to select it 
first, but I don’t have to



Right-click on products to bring 
up the context menu 

(Notice where my pointer is — on 
products)



Click on New File From Template…



The list of templates appears — we want HTML.html 

Type HTML until that template is selected & press ↩/Enter, 
or use your � to select it & press ↩/Enter,  
or just click on it



Enter the filename — in this case, product-1 
— & press ↩/Enter (do not add the .html, 
since it’s automatically put there for you)



And there’s our new file, inside 

products like I wanted ���



Here’s how to create a new file inside the wrong folder



I want to create another new file inside 
products named product-2.html



I should right-click on the 
products folder, but I’m not paying 
attention & instead right-click on 
foo.html (right-clicking in the 
empty area inside FOO would cause 
the same problem you’re about to 
see)



Click on New File From Template…



The list of templates appears — we want HTML.html



Enter the filename — in this case, product-2 — & 
press ↩/Enter (no need to add the .html, right?)



And there’s our new file, but it is not 

inside products like I wanted �



So what if you do make a mistake in where you create a 
file? 

It’s an easy fix: drag ’n’ drop!



Select the file in the wrong location 
(in this case, product-2.html)



Now drag product-2.html on top of 
products, the folder it should be in, & 
take your finger off your mouse (or 
trackpad) 

VS Code provides a nice blue back-
ground color to help you drag the file 
onto the correct target



When asked, click on Move



product-2.html is now where it 
should been if I had right-clicked 
on products in the first place



✏ SIDE NOTE

For a video about File Templates Manager, see Visual 
Studio Code - Extensions - File Templates Manager at 
vimeo.com/758916351



Live Preview 

ꕹ 
Microsoft



View your code live in a 
browser, as you work on it 

Make a change in the code, 
save it, & the webpage 
instantly updates in the 
browser



View your code live in a 
browser, as you work on it 

Make a change in the code, 
save it, & the webpage 
instantly updates in the 
browser



Basically, Live Preview starts a mini Web server on your 
computer  

That mini server lets you interact with your website just 
like a “real” one (e.g., Apache, Nginx, or IIS) would 
when you upload your site to the Web*

*Live Preview doesn’t do everything Apache, Nginx, or IIS does, which is why I called it a “mini” Web server



If you are on an HTML page, look up in the top right of 
VS Code’s window for this icon: 

You must be on an HTML page to see this button!



Click on       to start the local server, which 
immediately… 

» opens the Terminal panel to run the Live Preview 
command line program (go ahead & close the panel — 

it’s OK), and 
» opens the current HTML page in your default 

browser







To close the local server… 

» close the browser tab, or 
» press ^C/Ctrl+C in the terminal open in the Terminal 

panel



�PRO TIP

Leave the Live Preview running in your web browser! 

Do not close your web browser tab after looking at the 
webpage you’re working on! 

If the webpage is not updating when you save your 
code, then you can close the tab & click on the Live 
Preview button again



Projects+ 

ꕹ 
Fabio Spampinato



Manage saved projects



You will now see a 6th icon on the Activity Bar:  

Click it to view your saved projects 

Click on a project to switch to that project





Group projects!

Current project



To add a new project, invoke the Command Palette & 
enter project save 

Give the project a meaningful name & press Enter 

Enter an optional description & press Enter 

Enter an optional group (e.g., if you want to group your 
projects by client or course) & press Enter 

Your project now appears in Projects



HTMLHint 

ꕹ 
Mike Kaufman

https://marketplace.visualstudio.com/publishers/mkaufman


Finds & reports problems in your HTML



Doesn’t do anything after you install it unless you set 
rules in settings.json 

My settings.json has these essential rules in it:  
DTD must be present • <html> must include lang • 
<title> required • Tags must be lowercase & paired • 
No self-closing tags; e.g., <br /> • Attributes must be 
lowercase & not duplicated • Values must use double 
quotes & no extra spaces • No inline styles • Cannot 
repeat id • alt required on images



Most of these came from HTMLHint



Colors



Color Picker 

ꕹ 
anseki



Color Picker lets you generate colors using a GUI 

Supports named colors, hexadecimal, RGB/RGBA, & 
HSL/HSLA 

Click in a color & press ⌥C then P/Alt-C then P





indent-rainbow 

ꕹ 
oderwat



indent-rainbow colorizes your indentation levels





Automation



Placeholder Images 

ꕹ 
Jake Wilson



Easily insert placeholder images (temporary images 
while a design is still being finalized)



Supports the following services: 

» DummyImage.com 
» Fake Images Please 
» LoremFlickr 
» LoremPixel 
» Pipsum 
» placehold.it � Garbage — do not use 
» Placekitten 
» Placeskull 

» Unsplash ⭐

http://DummyImage.com
http://placehold.it


Invoke the Command Palette, enter in Placeholder, & 
select Placeholder Images: Insert new image 

Select the service you wish to use 

Enter the appropriate information























GrannePack HTML installs the following themes: 

» Monokai Dark Soda 
» Material Icon Theme



Themes



Personalize the way VS Code looks with a color theme, 
which changes the colors of everything in VS Code





VS Code comes with several color themes pre-installed: 

Abyss • Dark+ (default dark) • Kimbie Dark • High 
Contrast • Light+ (default light) • Monokai Dimmed • 
Monokai • Quiet Light • Red • Solarized Dark • 
Solarized Light • Tomorrow Night Blue



I included Monokai Dark Soda in GrannePack HTML





You can pick your own 

Go to Extensions View & search for color theme 

Click on a theme that interests you 

You should see a screenshot on the right to help you 
decide if you want to check out the theme 

No screenshot? Forget it!





I suggest starting with these, as they are widely 
supported by almost all code editors: 

» Solarized (light or dark) 
» Soda (weirdly, there aren’t any light Soda themes, but 
Espresso Soda by Daur Gamisonia works) 

» Monokai (I like Monokai Dark Soda by Adam 
Caviness, as it combines the best of Monokai & Dark 
Soda) 

» Material 
» GitHub 
» Dracula



When you find a theme you like, click 

After it installs, click 

: Code > Preferences > Color Theme 
⊞: File > Preferences > Color Theme 

The Command Palette will open showing all your 
themes 

Select the one you installed & press ↩/Enter to enable it



A file icon theme puts little icons to the left of your files 
when you are in Explorer View





VS Code comes with 1 icon theme pre-installed: Seti 

I included Material Icon Theme in GrannePack HTML







You can pick your own 

Go to Extensions View & search for icon theme 

Click on a theme that interests you 

You should see a screenshot on the right to help you 
decide if you want to check out the theme 

No screenshot? Forget it!



I suggest starting with these: 

» Material Icon Theme by Philipp Kief � what I use 
» vscode-icons by Roberto Huertas 
» VSCode Great Icons by Emmanuel Béziat



When you find a theme you like, click 

After it installs, click 

: Code > Preferences > File Icon Theme 
⊞: File > Preferences > File Icon Theme 

The Command Palette will open showing all your 
themes 

Select the one you installed & press ↩/Enter to enable it



marketplace.visualstudio.com



Extensions installed by GrannePack CSS

CSS Flexbox Cheatsheet Live Sass Compiler

IntelliSense for CSS class names in HTML



IntelliSense for CSS class names 

ꕹ 
Zignd



Autocomplete CSS classes in your HTML as you type



Go to the Extensions View & install IntelliSense for CSS 
class names by Zignd



As you type class=", a list of class names will appear 
from your local CSS files & any remote ones you’ve 
linked to 

As you continue to type — e.g., class="le — the list will 
narrow down 

Select the correct match & press ↩/Enter to 
autocomplete the class name









Narrow it down further…



Now press ↩/Enter…





Live Sass Compiler 

ꕹ 
Glenn Marks



Compile Sass into CSS manually or when you press 
Save 

More on this later!



Sass, before 
compiling into CSS



CSS, compiled 
from Sass



More 
Features



Debugging



VS Code helps you debug your code in 4 ways 

1. Syntax highlighting (colors) 
2. Warnings in the Status Bar & the Problems Panel 
3. Nesting via formatters 
4. Live Preview



Syntax Highlighting



Syntax highlighting colors your code based on the 
lexical categories of the language 

In HTML, you would see different colors for tag names, 
attributes, values, & comments 

Different languages are colored differently



Comments 
Tag names 
Attributes 
Values



Selectors 
Properties 
String values 
Functions 
Numeric values 
Units 
@rule 
Comments



�



�



�
�



�
�



Warning & the Problems Panel







Nesting via Formatters



If your code isn’t flowing correctly, something may be 
wrong



CSS



�



�



�



Live Preview



One of the most important 
tools for debugging



Code Folding



I want to collapse 
that <div> so I 
can see more code



Hover over the 
gutter & folding 
symbols appear



Click on the ⌄ 
symbol & that 
section collapses!



Click > & it 
expands back



You can use key 
commands too! 



Fold (collapse) region at the cursor 

» Command Palette: search for Fold  
» ⌘⌥[/Ctrl+Shift+[ 

Unfold collapsed region at the cursor 

» Command Palette: search for Unfold  
» ⌘⌥]/Ctrl+Shift+]



Nice, but what if I 
want to collapse 
everything?



Fold all regions in your code 

» Command Palette: search for Fold All 
» ⌘K ⌘0/Ctrl+K Ctrl+0 (zero) 

Unfold all regions in your code 

» Command Palette: search for Unfold All 
» ⌘K ⌘J/Ctrl+K Ctrl+J



Here’s what I suggest when you code 

Place your cursor on <body> & fold recursively 

» Command Palette: search for Fold Recursively 
» ⌘K ⌘[/Ctrl+K Ctrl+[ 

Click in various landmarks & unfold recursively 

» Command Palette: search for Unfold Recursively 
» ⌘K ⌘]/Ctrl+K Ctrl+]



Rename Tags



You type <em>Unknown Kadath</em> & realize you 
should’ve used <i> instead 

Normally you’d have to manually change both <em> &  
</em> to <i> & </i> �



With Rename Tags, built in to VS Code… 

» change <em> to <i>, & it automatically changes </em> 
to </i>, OR 

» change </em> to </i>, & it automatically changes  
<em> to <i>



✏ SIDE NOTE

I have enabled Rename Tags to run automatically in 
the Settings file I provided to you 

Without that automation, you’d have to run it 
manually by selecting the element & doing one of 
these: 

» Invoke the Command Palette (⌘⇧P/Ctrl-Shift-P) & 
search for On Type Rename Symbol 

» Press ⇧⌘F2/Shift+Ctrl+F2



Language Support



Built-in support for 

» CSS, Sass, & Less 
» HTML 
» JavaScript, JSON, & Node.js 
» Markdown 
» PHP 
» TypeScript



Extensions add support for other languages 

» C/C++ 
» C# 
» Go 
» Java 
» Python 
» Ruby 
» Rust 
» & many, many more



Git Integration



Git is the world’s most popular distributed version 
control system for tracking changes in source code files 
& coordinating work on those files among multiple 
people



VS Code has built-in support for Git











Thank you! 

scott@granneman.com 
www.granneman.com 
@scottgranneman@mastodon.social 

jans@websanity.com 
websanity.com
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granneman.com/downloads/web-dev/
HTML-Overview-Condensed.pdf 

chnsa.ws/html-condensed-slides

Notes 

granneman.com/downloads/web-dev/
HTML-Overview-Condensed.txt 

chnsa.ws/html-condensed-notes

https://granneman.com/downloads/web-dev/HTML-Overview-Condensed.pdf
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Bonus



Quick List of  
Installations & 
Configurations



These are the installations & configurations we perform 
throughout these slides 

I put them all here in 1 location as a reference



Install extensions 
⌘⇧P/Ctrl+Shift+P > Extensions: Install Extensions 
Search for GrannePack 
Install: 

» GrannePack HTML 
» GrannePack CSS 
» GrannePack Web Dev Snippets 
» GrannePack Web Dev Settings



HTML snippets 
Preferences > Configure User Snippets > html.json 
https://chnsa.ws/16e 

CSS snippets 
Preferences > Configure User Snippets > css.json 
https://chnsa.ws/1bo  

SCSS snippets 
Preferences > User Snippets > scss.json 
https://chnsa.ws/1bx 

http://chnsa.ws/16e
http://chnsa.ws/1bo
http://chnsa.ws/1bx


VS Code settings 
⌘⇧P/Ctrl+Shift+P > Open Settings (JSON) 
https://chnsa.ws/1c7 

Keyboard Shortcuts 
Preferences > Keyboard Shortcuts 
Set editor.action.joinLines to 
⌃J/Ctrl+J

http://chnsa.ws/1c7


Set editor.emmet.action.wrapWithAbbreviation to 
⌘E ⌘R/Ctrl+E Ctrl+R

Set editor.emmet.action.balanceOut to 
⌘E ⌘�/Ctrl+E Ctrl+� 

Set editor.emmet.action.balanceIn to 
⌘E ⌘�/Ctrl+E Ctrl+� 

Set editor.emmet.action.updateImageSize to 
⌘E ⌘I/Ctrl+E Ctrl+I



File Templates Manager 
Replace HTML.html template with 
https://chnsa.ws/1b1  

New Bootstrap 5 CDN.html template using 
https://chnsa.ws/1wx

https://chnsa.ws/1b1
https://chnsa.ws/1wx


Set up Project Templates 

Select Color theme 

Select File Icon theme



Installation



Portable VS Code



Don’t have a laptop you can install VS Code on? 

You can install Visual Studio Code in Portable Mode, 
which runs on…  

» a USB flash drive 
» a portable hard drive 
» cloud storage (Dropbox, One Drive, Box, iCloud 

Drive, or Google Drive)



When you use VS Code in Portable Mode, all your 
extensions, settings, & other data reside in a folder 
along with the app 

You can therefore access & use VS Code from anywhere 
& have access to your setup without having to reinstall 
or reconfigure!







A file named something like VSCode-darwin-
stable.zip will appear in Downloads 

Double-click on the ZIP file & a few moments later you 
will see Visual Studio Code.app



Drag VS Code into your Dropbox folder



Toss the ZIP file into the Trash (or just select the file & 
press ⌘⌦)



Go to your Applications folder 

Double-click on VS Code to open it 

Once it is open, go ahead & close it



In your Applications folder, create a new folder named 
exactly code-portable-data 

Now when you run VS Code, all your extensions & data 
will live in the code-portable-data folder



Next time you automatically update VS Code, 
everything should just work



c



Click on 
Other platforms



Click on 64 bit zip 
(unless you have an 
ancient PC)



A file named something like VSCode-win32-
x64-1.26.1.zip will download 

Right-click on the ZIP file & select Extract Here 

You should now have a folder named something like 
VSCode-win32-x64-1.26.1

Drag that folder into your USB or cloud drive



Toss the ZIP into the Recycle Bin



Go into the VS Code folder (e.g., VSCode-win32-
x64-1.26.1) & its 60+ items (!) 

Note that to run the VS Code app, you need to click on 
Code.exe 

Create a folder named data in the same folder as 
Code.exe 

Now when you run VS Code, all your extensions & data 
will live in the data folder



Next time you update VS Code, follow the same 
procedure with the ZIP file 

However, drag the data folder from the old installation 
folder (e.g., VSCode-win32-x64-1.26.1) into the new 
installation folder (e.g., VSCode-win32-x64-1.27.1) 

Toss the old installation folder (e.g., VSCode-win32-
x64-1.26.1) into the Recycle Bin







A file named something like code-stable-
1567547931.tar.gz will download 

tar -xvzf code-stable-1567547931

You should now have a folder named something like 
VSCode-linux-x64

Drag that folder into your USB or cloud drive



Go into the VSCode-linux-x64 folder 

Note that to run the VS Code app, you need to run code 

Create a folder named data in the same folder as code 

Now when you run VS Code, all your extensions & data 
will live in the data folder



Next time you update VS Code, follow the same 
procedure with the TAR.GZ file 

However, drag the data folder from the old installation 
folder into the new installation folder 

Toss the old installation folder into the Recycle Bin





You can also run VS Code in a Web browser in 3 ways 

» Directly in a GitHub repo 
» At vscode.dev 
» Codespaces





1. Open a GitHub repo in your browser 
2. Press . (a period) 
3. Whoa!







Completely free to every GitHub user!



vscode.dev





vscode.dev, using the default dark theme



None of my extensions are here



Click to open the Manage menu





I used GitHub





Immediately it switches to theme I’m using on my Mac



Extensions that will work on the Web show up now



Let’s check Settings…



& there all of mine are!







Try very hard not to open single files — VS Code 
wants you to work on projects/folders











“The Visual Studio Code Server is a service you can run on 
a remote development machine, like your desktop PC or 
a virtual machine (VM). It allows vou to securely connect 
to that remote machine from anywhere through a 
vscode.dev URL, without the requirement of SSH.”





Sign in to GitHub…









“Your changes will be committed and immediately pushed 
to the ‘main’ branch on GitHub.”



vscode.dev is completely free



Codespaces













“Codespaces is available for free for individual use for 
up to 60 hours a month and comes with simple, pay-
as-you-go pricing afterwards.”









Command Palette



⌘P/Ctrl+P lets you navigate to any file in the project by 
typing its name



⌘P/Ctrl+P



^R/Ctrl+R opens a list of recently opened folders & files 
in the Command Palette



After pressing ^R/Ctrl+R



⌘⇧O/Ctrl+Shift+O lets you use the Command Palette to 
jump to a specific symbol in a file



⌘⇧O/Ctrl+Shift+O



⌘⇧O/Ctrl+Shift+O



⌘⇧O/Ctrl+Shift+O



⌘⇧O/Ctrl+Shift+O



⌘⇧O/Ctrl+Shift+O



? shows you a list of available commands for VS Code 
itself, not the editor





Snippets



You create different snippets for different languages 

: Code > Preferences > Configure User Snippets 

⊞: File > Preferences > Configure User Snippets 

Select the language in the Command Palette 

A JSON-formatted file named [language].json opens





${0} denotes the 
final insertion point 
position





Everything in the Snippets section after this is not 
needed if you install the GrannePack Web Dev Snippets 
extension 

marketplace.visualstudio.com/items?
itemName=granneman.grannepack-html

https://marketplace.visualstudio.com/items?itemName=granneman.grannepack-html
https://marketplace.visualstudio.com/items?itemName=granneman.grannepack-html


I’ve already prepared html.json for you to use 

� � �

416 lines as of March 25, 2022



: Code > Preferences > Configure User Snippets 

⊞: File > Preferences > Configure User Snippets 

Type html & select it in the Command Palette 

A JSON-formatted file named html.json opens



Go to https://chnsa.ws/16e 

Click the Raw button 

On the following page, press ⌘A/Ctrl+A to select all of 
the code 

Press ⌘C/Ctrl+C to copy the snippet code (everything 
from — & including! — the first { to the last })

http://chnsa.ws/16e


Go back to VS Code & click in html.json 

Select all of the content in html.json by pressing ⌘A/
Ctrl+A 

Paste the snippets you copied with ⌘V/Ctrl+V, overwriting 
what was there 

Save what you just pasted in by pressing ⌘S/Ctrl+S 

Close html.json by clicking the × on its tab or by pressing 
⌘W/Ctrl+W



I’ve also already prepared css.json for you to use 

� � �

61 lines as of July 20, 2022



: Code > Preferences > Configure User Snippets 

⊞: File > Preferences > Configure User Snippets 

Type css & select it in the Command Palette 

A JSON-formatted file named css.json opens



Go to https://chnsa.ws/1bo 

Click the Raw button 

On the following page, press ⌘A/Ctrl+A to select all of 
the code 

Press ⌘C/Ctrl+C to copy the snippet code (everything 
from — & including! — the first { to the last })

http://chnsa.ws/1bo


Go back to VS Code & click in css.json 

Select all of the content in css.json by pressing ⌘A/Ctrl+A 

Paste the snippets you copied with ⌘V/Ctrl+V, overwriting 
what was there 

Save what you just pasted in by pressing ⌘S/Ctrl+S 

Close css.json by clicking the × on its tab or by pressing 
⌘W/Ctrl+W



✏ SIDE NOTE

Only needed if you’re in my CSS course 

I’ve also already prepared scss.json for you to use 

� � �

32 lines as of September 11, 2019



✏ SIDE NOTE

: Code > Preferences > User Snippets 

⊞: File > Preferences > User Snippets 

Type scss & select it in the Command Palette 

A JSON-formatted file named scss.json opens



✏ SIDE NOTE

Go to https://chnsa.ws/1bx 

Click the Raw button 

On the following page, press ⌘A/Ctrl+A to select all of 
the code 

Press ⌘C/Ctrl+C to copy the snippet code (everything 
from — & including! — the first { to the last })

http://chnsa.ws/1bx


✏ SIDE NOTE

Go back to VS Code & click in scss.json 

Select all of the content in scss.json by pressing ⌘A/
Ctrl+A 

Paste the snippets you copied with ⌘V/Ctrl+V, overwriting 
what was there 

Save what you just pasted in by pressing ⌘S/Ctrl+S 

Close scss.json by clicking the × on its tab or by pressing 
⌘W/Ctrl+W



Extensions



Project Templates 

ꕹ 
cantonios



Project Templates allows you to create entire projects 
from folders containing pre-made files & folders



Start by creating a 
folder & setting up 
the files & folders for 
a brand new project



Open Command Palette 
with ⌘⇧P/Ctrl+Shift+P & 
select Save Project as 
Template



Enter a name for your 
project template



You can now delete 
the folder you used to 
create your project 
template



Start with a new 
empty project folder



Open Command Palette 
with ⌘⇧P/Ctrl+Shift+P & 
select Create Project 
from Template



You’ll see a list of all 
your project templates



Click or type to filter 
the list



Congratulations — you 
have a new project!



File Utils 

ꕹ 
Steffen Leistner



File Utils makes it easy to duplicate, move, rename, & 
delete files & folders



Right-click on a file or folder & select: 

» Duplicate 
» Move 
» Rename 
» Delete





Auto Close Tag 

ꕹ 
Jun Han



VS Code has built-in support for auto-closing tags in 
HTML 

Type <p> & VS Code automatically creates </p> 

Auto Close Tag adds support for PHP, JavaScript, & 
other languages



Changelog 
 
2024-04-04 1.29: Clearer instructions for installing 
GrannePacks; nicer “Let’s take a tour” slide; improved 
Problems Panel screenshots; changed “conditions” to 
“criteria”; added slides showing relationship of project 
files, Open Editors, & tabs; added warning re: opening 
individual files instead of projects; order instead of ask 
to create ⌘E ⌘R



Changelog 
 
2024-02-06 1.28: Improved advice in Code Folding; 
changed Twitter link to Mastodon; added results of 
2023 Stack Overflow Developer Survey; updated & 
added screenshots to The User Interface 

2023-09-15 1.27: Updated location of templates used by 
File Templates Manager on Windows (thanks, 
Maddie!); moved extra snippets stuff into Bonus 
section; minor formatting corrections



Changelog 
 
2023-06-26 1.26: Removed almost all content from Initial Info 
into it’s own set of slides titled Essential Tech Info & Skills; 
changed title slides to new design & layout!; moved using VS 
Code in a Web browser to Bonus; changed theme to Granneman 
1.11; minor fixes 

2023-02-19 1.25: Added from & to for HTML 5 template; 
updated & reformatted lists of extensions installed in 
GrannePack HTML & GrannePack CSS; correct Install & Reload 
buttons in Themes; added note that Live Preview button only 
appears on HTML pages; added ul>li* trick Bailey discovered



Changelog 

2023-01-23 1.24: Removed CSS extensions that are no 
longer part of GrannePack CSS; removed HTML & CSS 
snippets & added GrannePack Web Dev Snippets 

2022-11-27 1.23: Upgraded theme to Granneman 1.8; 
disclosure buttons & printing dialogs have changed in 
macOS 13 Venture; minor fixes & formatting after theme 
upgrade; hid details about creating Snippets; corrected 
many Windows shortcuts from, e.g., Ctrl-A to Ctrl+A; had to 
re-do every single Key Command character style!



Changelog 

2022-11-25 1.22: It’s now Configure User Snippets; added 
other key commands to Quick List of Installations & 
Configurations; changed Emmet’s Wrap with Abbreviation 
to ⌘E ⌘R/Ctrl+E Ctrl+R (R instead of W) because that 
conflicts with running VS Code in a Web browser 

2022-11-12 1.21: Added details re: typing file extension in 
File Templates Manager; added quite a bit in Installation 
on using VS Code in a browser via GitHub, vscode.dev, or 
Codespaces



Changelog 

2022-10-27 1.20: Added detailed, extensive instructions 
for using File Templates Manager; updated Main 
Project Folder; added more & clarified Live Preview; 
added Searching to Initial Info 

2022-07-25 1.19: Fixed order of Panels; updated 
screenshots of IntelliSense & Emmet



Changelog 

2022-07-20 1.18: Added screenshot of Finder 
Preferences for turning on extensions; added small 
section on Mac Trackpads in Initial Info; added section 
on Debugging in More Features; added screenshots 
showing how to show file extensions in Windows 10 & 
11; added small detail to Color Picker; added note re 
differences between Visual Studio Code & Visual 
Studio; minor edits



Changelog 

2022-04-05 1.17: Changed all uses of VSCode to VS 
Code since that’s how Microsoft refers to it at its 
website; brand new screenshots for User Interface, with 
a few new slides; added screenshots explaining how to 
add Ctrl+J for Join Lines; clarified Emmet key 
commands; added key command for Emmet: Update 
Image Size; made Folding much better with good advice



Changelog 

2022-03-29 1.16: Recommended 2 settings to change 
after importing settings.json; fixed incorrect 
comment about commas after array values; unhid slide 
in Code Completion that was the main point of the 
section!; updated number of lines in html.json & 
css.json; updated Live Preview with better details & a 
short video; fixed minor typos; got rid of Path 
Autocomplete since it’s now built in



Changelog 

2022-01-30 1.15: Added section explaining why zipping is used; 
moved Portable VSCode to Bonus; moved ⌘P/Ctrl-P & ^R/
Ctrl+R to Bonus under Command Palette; moved Command 
Palette screenshots out of Bonus & back to Command Palette; 
rearranged sections to make things flow better 

2021-12-13 1.14: Added graphical example for / & \; removed 
Live Server & added Live Preview; moved ⌘⇧O/Ctrl-Shift-O to 
Bonus section; removed slides on GrannePack Git & GrannePack 
Markdown; renamed Extensions section to Extensions & Themes 
& simplified layout; re-ordered Key Features section



Changelog 

2021-06-17 1.13: Mentioned Emmet presentation in the 
Emmet section; added new Quick List of Installations & 
Configurations under Bonus; fixed broken link 

2021-04-21 1.12: Removed old Emmet wrap command, as 
it’s no longer supported in VSCode; changed Git to Git 
Integration; reordered sections under Key Features; 
added Quick List of Installations & Configurations under 
Bonus; fixed all chnsa.ws URLs so they use HTTPS



Changelog 

2021-04-02 1.11: Changed Why VSCode? triangle; 
removed duplicate Auto Close Tag slide; changed theme 
to Granneman 1.7; fixed minor formatting errors; added 
detail to Peeking; changed The GUI to The User Interface; 
added screenshots to Project Templates; added slide 
listing contents of GrannePack HTML & GrannePack CSS; 
added sections on Bracket Pair Colorizer ^, npm, & Style 
formatter 

2020-06-09 1.10: Minor fixes & updates



Changelog 

2020-04-11 1.9: Moved Configuration much higher; 
changed Emmet keyboard shortcuts to fit with new 
scheme; added Why VSCode? section; removed Auto 
Rename Tag because the functionality is now built in to 
VS Code 1.44 as Synced Regions; added keyboard 
shortcut to open Problems panel; removed CSS Peek 
because peeking is now built in, so explained; added CSS-
Specific section & added content; added Bonus section; 
added open recently-opened folders to Command Palette



Changelog 

2019-09-14 1.8: Removed expand-region by Le Trieu 
because Emmet does it; removed Sort Lines by Daniel 
Imms because now built in; added extension screenshots 

2019-09-11 1.7: Added css.json & scss.json snippets; 
added installation instructions for Linux; updated all GUI 
screenshots; added GrannePack slides & did a little 
rearranging; added section on Emmet; split 
Configuration into sections; little improvements 
everywhere



Changelog 

2018-11-29 1.6: Added section on macOS Disclosure 
Buttons in Initial Info; added screenshots for Windows 
zipping & unzipping; added slide re: zipping for macOS; 

2018-10-29 1.5: Minor formatting fixes; added slide re: 
Live Server port 5500; added hyperlinks to slide links; 
added DEMO! slide; cleaned up small stuff; added 
suggested keyboard shortcuts



Changelog 

2018-09-15 1.4: Switched out File Templates to File 
Templates Manager because the latter works on 
Windows; added details on unzipping 

2018-09-03 1.3: Took Your Username out of Initial Info 
& put it in with File Templates extension; Added / & \ to 
Initial Info; added instructions for using File Templates; 
added Side Note & Pro Tip to Live Server; labeled 
screenshots for HTMLHint & CSSTRee validator



Changelog 

2018-08-29 1.2: Added Initial Info section with macOS 
Meta Keys, Unzipping, Show Extensions, Main Project 
Folder, & Your Username; better instructions for 
copying html.json & settings.json; added icon for 
Extensions button in First Extensions; added note that 
Git is for advanced classes; much better instructions for 
installing color & file icon themes; better instructions 
for File Templates



Changelog 

2018-08-20 1.1: Updated Portable VSCode; added text 
re: commas in JSON 

2018-06-22 1.0: First release 



Licensing of this work 

This work is licensed under the Creative Commons Attribution-ShareAlike 4.0 International License. 
 
To view a copy of this license, visit http://creativecommons.org/licenses/by-sa/4.0/. 

You are free to: 

» Share — copy and redistribute the material in any medium or format 
» Adapt — remix, transform, and build upon the material for any purpose, even commercially 

Under the following terms: 

Attribution. You must give appropriate credit, provide a link to the license, and indicate if changes were made. 
You may do so in any reasonable manner, but not in any way that suggests the licensor endorses you or your 
use. Give credit to: 

Scott Granneman • www.granneman.com • scott@granneman.com 

Share Alike. If you remix, transform, or build upon the material, you must distribute your contributions under 
the same license as the original. 

No additional restrictions. You may not apply legal terms or technological measures that legally restrict others 
from doing anything the license permits. 

Questions? Email scott@granneman.com


